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Standards 
 
 
The equipment is tested to the following product standards: 
 
EMC:  EN60945 (2002), EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5, 

EN61000-4-6, EN61000-4-11, IEC60092-101 
Environmental: EN60945 (2002),  EN60068-2-1, EN60068-2-1, EN60068-2-2, EN60068-2-6, 

EN60068-2-30, EN60068-2-52 
Ingress protection: IEC60529 
Compass safe distance: EN ISO 694 
Health and Safety:  EN60950, CSA-C22.2 60950 
 
For an updated list of approvals and statements of conformity, these are available from: 
 

www.jotron.com 

 
 
 
 
 
 
 
 
 
  

http://www.jotron.com/
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The information in this book has been carefully checked and is believed to be accurate. However, no 
responsibility is assumed for inaccuracies. 
Jotron AS reserves the right to make changes without further notice to any products or modules 
described herein to improve reliability, function or design. Jotron AS does not assume any liability 
arising out of the application or use of the described product. 
 

SAFETY INSTRUCTIONS 
 

 
 
 

 
 
This equipment contains CMOS integrated circuits. Observe handling precautions to avoid static 
discharges which may damage these devices. 
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SERVICE AND WARRANTY 
Warranty time: 2 years from factory. 
All goods sold by Jotron AS are warranted to be free from defect in workmanship and 
material for the period of twenty-four (24) months from the date of delivery (unless stated 
otherwise and confirmed in writing) PROVIDED: 

(a) Jotron AS is given full particulars in writing of any claim prior to the expiration of 
such a period and within fourteen days of the discovery of the alleged defect. 

(b) The product/s have been stored, maintained or used according to manual/s and 
specification/s 

(c) Liability shall be limited at Jotron AS’ options to replacement or repair or to a sum 
not exceeding the net invoice value of the defective goods. 

(d) Upon request the alleged faulty goods are returned to Jotron AS at the Buyer’s 
expense. 

(e) Unless expressly stipulated in the acceptance of the order Jotron AS gives no 
warranty or guarantee of the fitness or suitability of the goods for any purpose 
whether disclosed or otherwise. 

(f) All other warranties or conditions expressed or implied are hereby excluded and 
Jotron AS shall in no circumstances be liable for consequential damages. 

 
UTILIZATION: 
This equipment is not to be disposed in normal waste, but be handled in accordance with 
applicable waste disposal regulations in the country where the equipment is used 
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1 SYSTEM DESCRIPTION 
 
The Integrated Communication System Phontech 6200 is designed to meet the requirements for 
internal communications and shore connections on board ships. 
The system is based on the Phontech 6200 unit. The exchange shall be built using one or more 1U 19 
inch Phontech 6200 units. 
 
The Phontech 6200 units have a built in 2 port fast Ethernet switch for cascading. It supports ring 
network for redundancy. One 1U unit supports up to 24 lines. FXS and FXO, 8 wire E&M and 
UpN(Dics) lines are supported. The unit will support a mix of up to 6 line modules with 4 lines each. 
Each line is terminated in a RJ45 jack. A typical PABX configuration could be 5 x 4FXS + 1x4 FXO for a 
total of 20 telephones and 4 trunks. Typical intercom configuration could be 4x4UpN + 4FXO + 4E&M. 
A 2x16 LCD character display with switches is provided to view status messages and configure basic 
functions. 
 
VoIP trunks and terminals are terminated using the Ethernet connection. Up to 50 VoIP (SIP) 
registrations per unit are supported. A number of SIP trunk lines are supported on each Phontech 
6200 unit. 
The exchange cabinet is normally located on the ships bridge, or the electronic equipment room. The 
intercom stations may be located in locations requiring two way communications, like the engine 
room, engine control room, mooring stations, generator rooms etc. 
 
The Phontech 6200 is tested and approved according to IEC 60945. 
The Phontech 6200 is backward compatible with Phontech DICS terminal hardware. 
Termination can be directly on the front panel using CAT5e type cable and RJ-45 connectors, or using 
19" patch panels and patch cables. 
 

1.1 MAJOR FUNCTIONS 
 
PABX operation. 
Intercom operation. 
Public address. 
Access to external systems and nets. 
Cost effective modular design. 
Flexible dual power supply configuration. 
Flexible Numbering plan 
Call groups 
Call hunting groups 
Paging groups 
Individual paging 
Intrusion 
Call transfer 
Call forwarding 
Wake up calls 
Who am I / Identification 
Automated switchboard 
Direct Inward Dialing  
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Conference bridge 
Configurable access control 
Redundant power supplies 
Self-diagnostic functions 
Field upgradeable hardware and software 
Programmable priority structure. 
 
 
Various intercom units for all purposes. 

 Office types. 

 Flush mounted. 

 Weather/ water protected types. 

 Noisy area compliant types with extra signal device activation and connection for headset 
and loudspeaker. 

 
Mechanical layout 

 
Electrical connections 
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1.2 STACKING 
 
Multiple Phontech 6200’s communicating using the Ethernet ports LAN1 and LAN2. The LAN1 and 
LAN2 ports are connected internally by a built in Ethernet switch. Interconnecting 6200 units is done 
by connecting Ethernet patch cables between the LAN ports. Three topologies are possible.  
 
1. Tree topology, which is the simplest. 
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2) Star topology, which includes the use of an external switch 
 

 
 
 
3. Ring topology, which has the added benefit of redundancy. 
 

 
 
 
The Ethernet connections have a maximum segment length of 100m. If longer segments are 
required, repeaters or media converters can be used. This allows for physical separation of multiple 
Phontech 6200 units within a single system. 
 

1.3 RACK MOUNTING 
 
It is recommended to arrange the Phontech 6200 units in pairs with a patch panel in between for 
easy patch cable arrangement. Ports 1-24 on upper 6200 unit will connect to the upper connector 
row on the patch panel, and the lower 6200 to the lower row. 
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Allow space for arranging the cables both inside and on the front of the cabinet. 

1.4 INSTALLING LINE BOARDS IN THE PHONTECH 6200 
 
The line boards are installed on the carrier board inside the Phontech 6200 unit. The line boards are 
color coded. 
 

 
 
Up to 6 line boards can be installed in any order on the carrier board. 
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Line interface board connectors relates to front panel ports in the following way: 
 

Line interface board Ports 

1 1 - 4 

2 5 - 8 

3 9 - 12 

4 13 – 16 

5 17 – 20 

6 21 – 24 

 

1.5 FXS BOARD 
 
The FXS line board supplies 4 lines of traditional analog telephone lines, aka POTS, Plain Old 
Telephone Service. The FXS line is connected to terminals 4 and 5 on the RJ-45 jack. Parallel 
connection of terminals is possible. 
 
 Line voltage -48VDC 
 Ring voltage 50VRms 
 Maximum REN 3  
 Loop current 25mADC 
 Signal levels according to ES 203-021 
 Line impedance  according to ES 203-021 
 
 
Supported terminals 
Jotron 5123, 5111, Gigaset 5020, Gigaset 5005, ResistTel Ex, FEP-2010 
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1.6 FXO BOARD 
 
The FXO line board supplies 4 trunk lines of the POTS type, Plain Old Telephone Service. This 
interface is the opposite side of the FXS interface, and is typically used to connect to shore lines, 
mobile networks and satellite trunks. 
  
 On-Hook Leakage Current 5uA 

Minimum line DC current 10mA 
Maximum line DC current 60mA 
Ringer equivalence number 0.2 
Ring voltage frequency range 13Hz-68Hz 
Signal levels according to ES 203-021 
Line impedance  according to ES 203-021 

 
The FXO line is connected to terminal 4 and 5 on the RJ-45 jack 
 

1.7 UPN BOARD 
 
The UPN line board supports 4 lines of Jotron Digital Intercom (DICS) lines. 
 
 Line voltage +37VDC 

Line impedance  110 ohms 
 
The UPN line is connected to terminal 4 and 5 on the RJ-45 jack 
The maximum recommended line length is 500m using 0.75 twisted pair ships cable. 
Parallel connection of terminals is not possible. 
 
Supported Terminals 
DICS 6111, 6112, 6113, 6114, 6123 and 6124 
 
 

1.8 E&M BOARD 
 
The E&M board is typically used to connect systems like PA/GA and VHF/UHF radio paging. 
It has two audio/key inputs and two audio/key output. 
The audio inputs can be either line level or microphone level with AGC.  The keying input accepts dry 
closing contacts. The audio output is line level with transformer isolation, they key output is a dry 
closing contact. 
 
 Output impedance 150ohms 
 Input impedance 4.7kohms 
 Nominal line level 0dBu 
 Maximum line level +3.15dBu 
 Nominal mic level -34dBu 
 Maximum mic level -17dBu 
 AGC range  44dB 
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The inputs are connected to the upper row of RJ-45 jacks, the outputs to the lower. The keying 
input/output is connected to 3 and 6 on the RJ-45 jack. The audio line is connected to terminal 4 and 
5. 

 

1.9 6200 POWER TERMINAL MODULE 
 
When the Phontech 6200 is installed in a cabinet, the 6200 power terminal module can be fitted, for 
easy termination of the required power supplies, as well as the power failure outputs. Power failure 
outputs are dry closing contacts, and are activated when the corresponding power supply fails. 
AC/DC version 

 
AC/AC version 
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1.10 TECHNICAL DATA 
 

Supply voltages  Universal AC input (110-230VAC) 
    DC input 24V nominal, 18VDC-72VDC 
Maximum power 
consumption  65W 
 
Size    445mm x 246mm x 44mm (w,d,h) 
Weight   2.5kg 
Capacity   24 physical lines, 48 registered SIP clients 

 

2 INSTALLATION 

2.1 INSTALLATION GUIDE 
 
The installation should be planned in details before commencing. The cables should be listed in a 
cable plan, with number of pairs etc. 
The location of each unit in the communication system should be planned to obtain maximum 
performance and user availability. 
The locations of the intercom stations and telephones with regards to the operators must be taken 
especially into consideration. 
Jotron strongly recommend the use of junction boxes for the external cable distribution. 
 

2.1.1 CABLE TERMINATION 
First, ensure that the cable to be used is according to the Jotron specifications.  
See the CABLE REQUIREMENTS chapter in this document. 
 

2.1.2 GLANDS 
The cables enter the WP units by means of cable glands. Where cable glands are not supplied from 
the factory, the installer must adapt the glands to the actual cable outer diameter. This is to obtain 
the specified ingress protection. 
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2.1.3 PUNCH BLOCK TERMINALS 
Be sure to use the correct tool (XXXXX) when terminating cables in the punch block terminals. 
Observe cable specifications. 
 

2.1.4 FERRULING 
The conductors should be ferruled prior to termination when using cage clamp terminals 
 

2.1.5 MARKING 
Each cable is to be marked with cable numbers. 
Each conductor is to be marked with the specific termination numbers. 
Please note that Jotron uses plug-able screw terminals in almost all units. This is to make the 
installation and service work as easy and durable as possible. 
 

2.1.6 FASTENING 
 
Where applicable, the cables and the conductors shall be clamped to the structure with cable ties. 
 

2.1.7 PRESERVATION 
 
Prior to, during, and after completion of the installation the equipment surfaces are to be protected 
against acid holding fluids, pollution, moist, impacts etc. 
This is in order to avoid damaged equipment for which Jotron will claim void warranty. 
 

2.1.8 SCREEN CONNECTION 
 
In order to obtain maximum performance after installation, it is necessary to terminate the cables 
and ground the screens in a good manner. 
The cables are to be de-isolated by removing approximately 500 mm of the outer insulation. 
Then the screen braid is cut off approximately 30 mm longer than the outer isolation. 
The conductors are to be de-isolated and ferruled before they are inserted into the terminals. 
The outer screen is clamped to the cable fixing rails inside the cabinet. Cable ties of a conductive type 
(metal) are recommended for best result. 
 

2.1.9 CABLE REQUIREMENTS 
 
All cables used with the DICS system must be of approved ship cable type. 
 
The cables must be: 
• Individually twisted pairs 
• Recommended conductor size is 0.75 mm² 
• All cabling in the 6200 must be a separate network. 
• DO NOT COMBINE DIFFERENT SYSTEMS IN THE SAME CABLE. THIS IS TO 
PREVENT DISTURBANCE AND NOISE CAUSED BY INTERFERENCE. 
 
Between the exchange and intercom / telephones: 1 pair. 
If extra signal device / loudspeaker: 1 extra pair for 24 VDC (total 2 pairs) 
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Power cables: 1 pair + Ground 
 

2.1.10 CABLE REQUIREMENTS FOR ETHERNET 
 
The Ethernet cables must be of specification category 5e UTP or better. 
Jotron recommends using the TIA/EIA-568-B.1-2001 termination scheme. 
The maximum length of each segment must be less than 100m 
 

2.1.11 COMPLYING WITH IMO REQUIREMENTS  
 
The Phontech 6200 system will comply with IMO requirements for two way voice communication 
systems only if the following is adhered to: 
 

 Extensions located on the navigation bridge and ECR must have the "Priority access' 
checkbox checked. An alternative is for these extensions to be a member of a class where the 
'Priority access" checkbox is checked. This will give these extensions the highest priority in 
the system. 

 When telephones are mounted in close proximity on the above mentioned locations, the ring 
tones on adjacent telephones should be selected so that incoming calls are distinguishable. 
See the user manual for the respective telephones for information on how to achieve this. 

 The Phontech 6200 system must be connected to both mains and emergency power. At least 
one of the power inputs must be connected to a power source capable of supplying the 
Phontech 6200 system during blackout. 

 

2.1.12 PHONTECH 6200 COMMISSIONING PROCEDURE 
 

2.1.13 COMMISSIONING TEST 
 
The Phontech 6200 shall be configured according to the customer requirement. 
 
Tests to be performed 
 

 Handbook is delivered and available for commissioning 

 Check the installation according to installation instructions 

 Using the Amity configuration as reference, for each extension check: 

 The installed terminal type 

 The local extension name and number 

 Class membership and priority service 

 Group memberships 

 If applicable, the hotline extensions 

 If applicable, access control 

 If applicable PA group memberships 

 If applicable Auto answer 
 
For trunk lines 

 Check trunk type 



 
 

Jotron AS| Phontech 6200: Installation manual    Installation Page 2-12 

P/N: 87299 (v.D) 

 Check prefix and DID 

 Check access control and billing 
 

2.2 NETWORK RECOMMENDATIONS 

2.2.1 OVERVIEW 
 
This section describes how the Phontech 6200 is designed to use an Ethernet network to 
communicate with other Phontech 6200 units, VoIP telephones and VoIP trunks, how to set up the 
Phontech 6200 system in a separate network - either physically or via IEEE 802.1q VLANs as 
supported by many modern switches - and some of the precautions that have to be taken into 
account when using IEEE 802.3af-2003 Power over Ethernet for VoIP telephones. 

2.2.2 PHONTECH 6200 NETWORK CONFIGURATION 
 
When setting up the 6200 units, one must first run through the “First Run Wizard” as described in 
Section 2.4.3. The number chosen for the 6200 unit here will determine a few things, among these 
the IP-address the 6200 unit will use. By default, all 6200 units will use the 172.16.0.0/16 network 
block, and the 6200 unit that has been set up as number 1 will always run a DHCP server which will 
serve addresses in the 172.16.1.0/24 block to clients. The number and IP address of an 6200 unit unit 
that has already been set up can be viewed via the front panel display as described in Section 
2.4.4.5.1. 
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In the above example diagram, there are three 6200 units arranged in order, as well as several VoIP 
telephones which receive an IP address from 6200 unit number 1 via DHCP. 
 
By default, each 6200 unit will route external traffic via 172.16.0.254. Also by default, DNS requests 
will be sent to 172.16.0.254. If an external VoIP trunk is required, please make sure that the router is 
correctly configured to route IP-traffic and to answer DNS requests. 
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We recommend installing the Phontech 6200 system in a physically separate network or in a 
separate 802.1q VLAN. 

2.2.3  INSTALLING THE PHONTECH 6200 IN A SEPARATE NETWORK 
 
Using a physically separate network is the simplest method of installing a Phontech 6200 system. It 
allows you to isolate the PBX from the rest of your network at the cost of separate infrastructure. 
This is typically the approach taken if there are few to none VoIP telephones or trunks in a Phontech 
6200 system, as there is little need to share infrastructure in these cases. 
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In the above example, three Phontech 6200 units are connected in a redundant ring while being 
separate from the main network. Please note that this also implies separate cabling for the VoIP 
telephones present. 

2.2.4 INSTALLING THE PHONTECH 6200 IN A SEPARATE 802.1Q VLAN 
 
It is also possible to install the Phontech 6200 system in a network separated by using 802.1q VLANs. 
This method allows you to share infrastructure and cabling that would otherwise have had to be 
duplicated. A VLAN is a virtual LAN that will in effect act as a completely separate network despite 
passing through the same infrastructure and possibly the same cabling; using a VLAN tag to define 
which network the traffic belongs to. It is possible to have up to 4096 different VLANs. Please note 
that in order to use VLANs, you need VLAN-capable infrastructure. 
A common way to organize traffic into VLANs is to separate different independent services into 
separate VLANs. 
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In the example above, traffic is separated into a “Voice VLAN” (with an ID of 50) and a “Data VLAN” 
(with an ID of 60). The “Voice VLAN” is able to use the same infrastructure as the regular “Data 
VLAN” by configuring the switches to tag the traffic appropriately depending on the port it is plugged 
into. This may be configured by making sure that the port the VoIP telephone is placed on has ingress 
tag of 50 and the egress traffic is untagged. Similarly, a computer would have an ingress tag of 60 and 
the egress traffic is untagged. 
It is also possible to allow several VLANs to share one port, by making sure that at least all but one of 
them is tagging egress traffic. In this approach, the end-point must be VLAN-aware in order to 
receive any of the tagged traffic. This could be used to share a port between a computer and a VoIP 
telephone. 

 
For more complex scenarios, please contact Jotron for a feasibility study. 

2.2.5 USING 802.3AF-2003 POE FOR VOIP TELEPHONES 
Power over Ethernet (“PoE”) allows units which supports it to replace the usual “wall wart” power 
supplies that are commonly used for most electrical products. To take advantage of this, a PoE-
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capable switch must be used, the end-point must support PoE and the length of the cabling between 
the two may not exceed 100 meters, as per 802.3af-2003. If cable lengths greater than this is 
desired, please consider distributing one or more switches closer to the end-point, make use of a 
PoE-capable repeater or use a PoE-injector closer to the end-point. 

 
For PoE, we recommend category 5 cabling or better. 
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2.3 CONFIGURATION APPLICATION 
 
 

2.3.1 Prerequisites 
 

2.3.1.1 REQUIREMENTS 
 
The Phontech 6200 Configuration Application requires the following: 
- Windows XP SP3, Windows Vista SP1, Windows 7 or later. 
- At least 1 GHz CPU speed. 
- At least 512MiB of RAM. 
- At least 500MiB of free disk space. 
- 100 Mbit/s Wired Network Connection. 
The recommended setup is: 
- Windows 7 or later. 
- 2Ghz dual-core CPU or better. 
- 4GiB of RAM or better. 
- 2GiB of free disk space or better. 
- 100 Mbit/s Wired Network Connection. 
 

2.3.2 INSTALLATION 
 
To install the application, run the supplied installer and follow the instructions given.  
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2.3.3 STARTING THE APPLICATION 
 
After installation, the application may be found in the "Start"-menu, under "Jotron AS/ICS6200 
Configuration Application". 

 
Figure 1 - Start Menu Entry 
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If you have installed a firewall, you may get a dialog asking you if the application should have access 
to the network. It is safe to answer "Yes" in this dialog. If you have Windows Vista or Windows 7, 
please allow the application access for "Home", "Work" and "Public" networks. 
 

 
Figure 2 - Firewall Settings 

 

2.3.4 COMMON TASKS 
 

2.3.4.1 CONNECTING TO A PHONTECH 6200 NETWORK 
 
In order to connect to and configure a Phontech 6200 system, you must connect your computer to 
the Phontech 6200 network. Make sure that your computer is set up to automatically acquire 
network addresses, and connect your computer to one of the LAN ports on the front of the 6200. 
Alternatively, you may connect your computer to the switch used for VoIP telephony if applicable. 
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Figure 3 - DHCP Settings 

 
Verify that your computer is connected to the Phontech 6200 network by checking that it has set an 
IP-address. Note that the IP-address shown here is in the 172.16.1.0/24 range. 
 

 
Figure 4 - IP Address 

 
If you are running Windows Vista or Windows 7, you may receive a dialog asking you what kind of 
network you have connected to. Please select either "Home Network" or "Work Network" if 
prompted, as this will affect firewall settings. In the case where the 6200 network is automatically 
configured as a "Public Network", make sure that the firewall settings are as described in section 
2.3.3. 
 
This can be checked by running "ipconfig" in a command window. "Start -> Run -> cmd -> ipconfig". 
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2.3.4.2  MAKING CHANGES AND SAVING THEM 
 
When making changes to the configuration in the configuration application, it is important to note 
that the changes are not applied to the Phontech 6200 system until you choose to send them. 
Sending your changes can be done via the toolbar, or via "File -> Send". 
 

 
Figure 5 - Send Configuration 

 

 
Figure 6 - Send Configuration in File-menu 
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The configuration can also be saved to disk using the regular "Save" or "Save as..." commands. Note 
that this does not imply the "Send" operation - this must be performed separately. 
 

 
Figure 7 - Save Configuration 

 
Please note that if you have just set up users on a new Phontech 6200 Unit or a unit that you have 
just installed new line interface boards on, the configuration application will have to perform some 
more intrusive set up procedures, which will cause any ongoing calls on the unit to be terminated. A 
pop-up dialog box will warn you of this before performing this action. 

 
Figure 8 - Required Restart of Analogue Lines 

2.3.4.3 FIRST STEPS 
 
Upon successfully connecting to a Phontech 6200 and starting the configuration application, it will 
automatically discover all 6200 units in the network and download the current configuration. 
If the system is newly installed (that is, having just completed the "First Run"-wizard as described in 
the installation guide), an empty configuration is in effect. 
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2.3.4.4 ADDING USERS 
 
To add users to the system, please use the Add Multiple Users Wizard. It can be started from the 
start view or from the menu bar under "Users". 
 

 
Figure 9 - Add Users 

 
Once you have started the wizard, you will be greeted by an introduction describing the wizard you 
have just started. Continue the wizard by clicking the 'Next'-button. This will lead you to the page 
were you enter the details for the new users. 
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Figure 10 - Add Users: Extension, Name, Types and Class membership 

 
When you create new users you have to enter the extension number, user name and the interface  in 
use by this user. The extension number is the number to call if anyone wants to reach this user. The 
user name is used as a description in the configuration application and will be displayed as the caller 
ID if the dialed phone supports a character display. The interface decides how the phone is 
connected physically and which features the user supports. The different interface alternatives are: 
 
- Analog (FXS): The "regular" station interface. Requires an unused port on a FXS line interface. 

Please note that Analog telephones do not support paging or alert groups. 
- Digital (UpN): The Jotron proprietary digital interface. Requires an unused port on an UpN line 

interface. 
- Snom 300: The Snom 300 brand VoIP telephone. Allows you to enter a provisioning MAC 

address which will be used to automatically configure the telephone. Requires an unused VoIP 
license. 

- SIP: A generic SIP account which may be used for other VoIP phones. Requires an unused SIP 
license. 

 
It is possible, but optional to assign the new user to one or more classes. These can be useful in 
segmenting access to different kinds of features to different sets of users. Classes will be discussed in 
"Managing Users with Classes". 
 
One or more rows may be added by clicking the green plus icon. The number of rows added is 
determined by the number entered in the input next to the icon. Each new row is automatically 
assigned a new extension number based on the previous row and will inherit the user type and class 
membership of the previous row by default. 
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Given that one or more of the new users are of the FXS or UpN type, you must now choose which 
ports to use. You will be presented with a visual representation of the Phontech 6200 system, where 
you can pick the desired port on the desired unit. The ports to select are determined by the type of 
users you have created. You will be presented with a view of the system once for each technology 
that uses the physical ports. The current interface is described in the upper left corner of the page. 
The right side of the page lists the users that are to be placed in the system. A blue text means that 
this is the user that will be placed with the next click. A gray name means that this user has already 
been placed and a black name signals that this user has not been placed yet. Numbers will be 
displayed on the visual representation to indicate which user has been selected for any placed port. 
 

 
Figure 11 - Add Users: Port Placement Page 

 
When placing multiple users, the "Auto Populate" function can be a timesaver. This will automatically 
pick unused ports for you in a sequential fashion. 
 
If one or more of the new users are of a Snom 300 variant, you must enter the provisioning MAC 
address of the handset. This allows the Phontech 6200 system to automatically provision the 
configuration to the handset once it is connected. 
 
If you have exceeded all the available licenses for SIP and Snom 300 users you will be notified in the 
bottom of the wizard page and you will not be able to add the users. To add more users of this type, 
please see the licenses section of this manual. 
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Figure 12 - Add Users: Adding SIP and Snom 300 Users 

 
Additionally, if one or more of the new users are of a Snom 300 or SIP type, one may select which 
6200 unit they shall be registered on. The configuration application will automatically select this, 
based on how many VoIP phones are registered on each unit already, but this can be changed here. 

 
Figure 13 - Add Users: Registration Info for SIP and Snom 300 
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2.3.4.5 MANAGING USERS WITH CLASSES 
 
A class is a collection or set of users that may share some properties. It is an optional feature that 
may be used to simplify certain parts of the configuration of large systems. 

 
Figure 14 - Adding Classes 

 
Consider a system where a subset of users - let us call them "Officers" – have access to a number of 
features - such as paging groups, dialing out over a trunk interface or high priority access to certain 
users. If we were to add or remove users from this set of Officers, we would have to manually change 
or update the permissions of each of these features - a process which may be error prone or easy to 
forget. This may be simplified by creating an "Officer"-class, which holds all of the relevant users. This 
class would be the only member which had access to the features in question, and the issue of 
adding or removing users from having access to these features is now simply a case of adding or 
removing users from this class. 
 
By default, the system contains one predefined class, which holds all users. 
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To add classes, please use the "Add Classes Wizard". 

 
Figure 15 - Adding Classes 
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To assign class membership to users, you may use the "User Properties" or "Class Properties" dialogs 
for existing users, or select the desired class when adding new users.  

 
Figure 16 - Adding Members to a Class Using "Class Properties” 
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Figure 17 - Assigning Class Membership in the “User Properties” Window 

 

2.3.4.6 ADDING A GROUP 
 
Groups provide different functionality on a set of users that are members of the group. The 
functionality differs on the type of group: 
- Call Group: When the group extension is dialed, the group will call all of its members 

simultaneously. The member to first pick up the phone will receive the call. 
- Call Hunting Group: When the group extension is dialed, the group will dial all of its members 

sequentially in a pre-defined order. The first member who picks up the phone will receive the 
call. 

- Paging Group: When the group extension is dialed, the call will be automatically paged out on 
the speakers of the members of the group. This requires paging support on the phones that are 
members of the group. 

- Alert Group: The alert group allows a sound to be played on the speaker of the members of the 
group, based on an external input. This requires an unused E&M input port, as well as paging 
support on the phones that are members of the group. 
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To add a group, start the relevant group type wizard.  
 

 
Figure 18 - Adding an Alert Group 

 
The first step is to enter a name and optionally a description for the group. Unless the group is an 
Alert group, you will also have to enter an extension for the group. If the group is an Alert group, we 
will have to select an unused E&M pair to be used as the source of the alert.  
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Figure 19 - Selecting the Input for the Alert Group 

 
We will then select the members of the group. You may select classes, individual users and, in some 
cases, even other groups. If the group you are adding requires paging functionality, only uses which 
support this is listed. 
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Figure 20 - Adding members to the Alert Group. Note that only users which support paging are listed 

 
Please note that the order of the members is significant in the Call Hunting group, and may be 
adjusted using the arrow buttons. For all other groups, the order of the members is insignificant. 
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Figure 21 - Arranging members in a Hunting Group 

 
Once the members have been added, all we need to do is verify that the information we entered is 
correct. 
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Figure 22 - Verifying a new Call Group 

 

2.3.4.7 ADDING A TRUNK LINE 
 
A Trunk Line allows you to connect your Phontech 6200 system to another PBX or the public 
telephone system. Different methods may be used to dial out over the trunk or receive calls from the 
trunk. 
The different types of trunks provided are: 
- SIP client: A 6200 unit will register with a remote SIP server and route calls to and from this 

server. Requires an unused SIP license. 
- SIP server: A 6200 unit will act as a SIP server for a remote client, and route calls to and from this 

client. Requires an unused SIP license. 
- FXO: Allows you to connect the Phontech 6200 system to an FXS interface of a remote PBX or 

what is commonly called PSTN. Requires one or more unused FXO ports. 
- E&M Allows you to connect the Phontech 6200 system to an external system providing key and 

audio signals. For example, a PAGA system.  Requires an unused input/output pair on an E&M 
module. 

 
To add a Trunk Line, start the "Add Trunk Line Wizard". The first step is to enter a name and 
optionally a description for the new Trunk Line. Once this has been completed, we will have to select 
the type of trunk as described above. 
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Figure 23 - Adding a Trunk Line 

 
Figure 24 - Selecting the Type of the new Trunk Line 
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If the trunk type is SIP client, you will have to enter the IP-address or hostname of the provider, as 
well as the username, password and realm as supplied by your provider. The 6200 drop down defines 
which 6200 unit in the network the Trunk Line shall be added to. 
The "Behind NAT" checkbox should be checked if the 6200 unit the trunk is added to is behind a 
network address translation layer and must traverse this in order to reach the server. If in doubt, 
leave this checked. If the remote server uses multiple IP-addresses to initiate calls to the 6200 due to 
load balancing, it is possible to resolve all the hostname addresses using the next checkbox. Please 
note that if your provider changes their IP-addresses, you must re-send your configuration to the 
6200 network in order to regenerate the trunk settings. If in doubt, leave this unchecked. 
 
If the trunk type is a SIP server, you must define the user name, password and realm you have or will 
use on the remote SIP client. You must also select which 6200 unit the client will be registered on. 
 
If the trunk type is FXO or E&M, you have to select which port(s) to use. You can optionally select 
multiple FXO ports for load balancing. 

 
Figure 25 - Selecting an FXO Port 

 
The next step is to select what action to take when an incoming call is detected. The Phontech 6200 
can call one or more extensions directly by selecting "Call an extension", give a switchboard-like 
greeting by selecting "Switchboard" or use the supplied number to directly call the intended recipient 
using "Direct Inward Dialing". Alternatively, incoming calls may be disabled. 
 
Selecting the “Park incoming calls” option when “Call an extension” is selected will change the 
behavior of how the incoming call is dealt with. First a preconfigured phone will ring and answer the 
incoming call. As the call is answered, the system will notify the one who answered the call that a 
parking number has been allocated for the caller. Once the one who answered the call hangs up, the 
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caller will be placed in the parking slot announced and another user can dial the configured retrieval 
extension and enter the parking room number to retrieve the call. This extension number is 
configured in the Phontech 6200 System Settings and if it is already configured it will be displayed 
below the checkbox for the parking option. This option can also be changed from the “Incoming Call 
Actions” tab in the Trunk Line properties screen. 
 
 

 
Figure 26 - Selecting which action to take upon incoming calls 

 
Note that the Direct Inward Dialing option is only available for SIP trunk lines. 
 
Unless incoming calls are disabled, you must select which users and/or groups should be reachable 
through this trunk. Users or groups who are not selected in this step may not be called from the 
trunk, regardless of the selected incoming call action. 



 
 

Jotron AS| Phontech 6200: Installation manual    Installation Page 2-40 

P/N: 87299 (v.D) 

 
Figure 27 - Select which users who should be reachable from incoming calls 

 
We must also define the outgoing behavior. This can either be "Prefix and dial out extension" - which 
allows your users to dial out using the trunk with both a prefix and a dial out extension, "Decided by 
extension length" - which sends a call over the trunk line if the dialed number is longer than the 
configured number of digits. "Dial out extension only" - which only provides a dial out extension for 
your users or disabled entirely. Dial out can also be set to "Disabled" if it should not be possible 
under any circumstances to call out with this trunk line. 
 
It is also possible to enable call logging on a trunk line. For this option to be active you must have a 
6200 Storage unit connected to your ICS 6200 network. See more information about this under the 
"Configuring storage" and "Call logging" sections. 
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Figure 28 - Outgoing calls behaviour 

 
Unless dialing out over the trunk is disabled, you must now select the dial out extension, and 
optionally prefix. If "Direct Inward Dialing" was selected during choosing the incoming actions, you 
must now supply your DID-prefix and fallback number in case we do not have a correct prefix to 
send. 
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Figure 29 - Supply the extension or prefix number to use 

 
Finally, please verify that the information is correct. 
 
Many additional settings such as restricting access to dialing out over the trunk, different sounds and 
other tweaks are changeable from the properties page for a trunk line. This is described in chapters 
such as "Access Control", "Call Logging" and "Custom System Sounds". 

2.3.4.8 PRINTING THE CONFIGURATION 
 
In order to get a hard copy of the configuration, you may use the "Print Extension Layout" function. 
This will give you a printout describing the current layout of the configuration, including extension, 
type and port number or MAC address / SIP password. All of this is listed per 6200 unit and grouped 
into physical extensions and VoIP extensions. 
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Figure 30 - Printing the Configuration 

 

2.3.4.9 MARK AS GOOD 
 
If you are happy with the configuration at this point, it is useful to run the "Mark as Good" function 
on the 6200 unit. Please consult the Phontech 6200 Firmware documentation for instructions on how 
to run this function, or how to restore a known good image. 
 

2.3.5 LESS COMMON TASKS 
 

2.3.5.1 SIP LICENSES 
 
To be able to use SIP or Snom 300 telephones in your ICS system, you have to have a SIP license 
installed. This license will be provided to you by Jotron AS. To check the current status of your SIP 
license you can go to the "Help -> Info" item from the menu bar. If you click the "Licenses" tab you 
should see the status of your license. If this tab is grayed out you do not have any license installed. 
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Figure 31 - License Information 

 
To acquire a new license from Jotron AS or upgrade an old one you can use the "Request License 
Quote" dialog. This can be found under the "Help -> Request License Quote" menu. 
 

 
Figure 32 - Request License Quote Menu Item 

 
Fill out the dialog to request the number of SIP licenses you want and click the "Save" button to get a 
file that contains all this information. Then send this file to sales@jotron.com and you will be 
instructed on how to proceed with the order. 
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Figure 33 - Request License Quote Dialog 

 
To make sure the license will be correct make sure all Phontech 6200 Units have been connected to 
the system 
 
When you receive a license file you must import it to the configuration. Be sure to keep this license 
file safe as you will need it again if you want to create a new configuration from scratch for this 
system. Go to the "File -> Import License" menu item and select the license file you were provided. 
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Figure 34 - Import License 

 
If the license file you selected was valid you will be notified about this and you can check the status 
of your license under "Help -> Info" as explained earlier. 
 

 
Figure 35 - License Import Successful 

2.3.5.2 ACCESS CONTROL 
 
In order to restrict access to certain resources, it is possible to set up Access Control via the 
configuration application. Access Control means that only a specific predefined set of users may use 
the resource. It is set up using the properties dialog of the resource in question. 
 
In the dialog, simply set up who should have access to the resource. 
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Figure 36 - Access Control for a Group 

 

 
Figure 37 - Restricting access to a Group 
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Figure 38 - Viewing the Access Control settings of a Class 

 

 
Figure 39 - Restricting Access to a User 
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2.3.5.3 HOTLINE 
 
Hotline mode is the ability of having a telephone automatically dial an extension upon going off 
hook. It is possible to set up on analog or digital users by using the properties dialog of the user in 
question and opening the hotline tab. 
 

 
Figure 40 - Enabling Hotline for a User 

 
Please note that this means that this user may only reach the recipient(s) specified in the hotline tab 
as he or she may no longer dial extensions. 
 

2.3.5.4 HIGH PRIORITY CALLS 
 
High Priority Calls is the ability to always be able to reach users regardless if they are already in a 
conversation. This functionality is enabled on a specific user or class. It can be turned on by checking 
the checkbox titled "This user/class can intrude into other users’ calls". Any user with this enabled 
will be able to intrude into other users calls by pressing '1' when queried. Please note that the other 
party will be disconnected. 
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Figure 41 - Enabling High Priority for a User 

2.3.5.1 MODIFYING PHONTECH 6200 SYSTEM SETTINGS 
 
The Phontech 6200 System Settings dialog allows you to configure certain system-wide features. 
Among these are the “Time”-settings, “SNMP”-settings and the system wide “Analog Phone” 
settings.  
 
Using this dialog, it is possible to set the time to a specific time zone and to synchronise the time to 
an external NTP-server. This can be useful when you want to synchronise time across multiple 
different systems to avoid that their perception of time drifts between them. “Local time” is the 
default setting, meaning that the system will use its internal clock to keep track of time. The local 
time and date can be set on the Phontech 6200 units using the front panel display. 
 
It is also possible to set the SNMP settings for the Phontech 6200 system in the tab labeld “SNMP 
Settings”. The system is capable of supporting both version 2 and 3 of the protocol. By default, 
version 2 is enabled. When using SNMP version 2, the community string must be set. By default, this 
is set to “ics6200”. 
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Figure 42 - Phontech 6200 System Settings – Time Settings 

 

 
Figure 43 - Phontech 6200 System Settings - SNMP Settings 

 
To enable version 3 of the protocol, simply select the correct version from the dialog and enter the 
desired login information. 
The authentication method, encryption method and security level may be changed from this dialog, 
but the defaults should suffice for most cases. When in doubt, leave this unchanged. 



 
 

Jotron AS| Phontech 6200: Installation manual    Installation Page 2-52 

P/N: 87299 (v.D) 

 

 
Figure 44 - Setting up SNMP Version 3 

 
If you wish to receive traps from the Phontech 6200 system, please enable the checkbox and enter a 
valid IP-address, optionally followed by a port. The host entered here will receive traps concerning 
common hardware failures such as power supply failures, fan failures or earth faults. 
 

 
Figure 45 - Phontech 6200 System Settings - Analog Phone Settings 
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System wide settings for analog phones are configured in the “Analog Phone Settings” tab. Here the 
settings for the “Flash” function can be changed. 
 
The extension to retrieve calls stored in the incoming trunk line parking lot can be configured from 
the “Trunk Line Parking Settings” tab. Here you can input the extension number that must be called 
to retrieve the stored calls. Once a user dials this number, he or she will be asked to enter the 
parking room number given to the operator who first answered the call. This page will warn if there 
are no trunk lines configured with the parking capabilities or if the selected extension is already in 
use. 
 

 
Figure 46 - Phontech 6200 System Settings - Trunk Lien Parking Settings 
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2.3.5.2 CONFIGURING STORAGE 
 
The ICS6200 Storage Settings dialog allows you to configure the storage devices in your network. This 
is required to make use of call logging functionality. The dialog can be found under the 'Tools' menu. 
 

 
Figure 47 - Phontech 6200 Storage Settings 

 
Before any call logging setting can be changed, you must first select a storage unit to be used in the 
network. This is done in the drop down box in the upper left part of the page view. The other settings 
can only be changed after this has been done. 
 
From this screen you can change the username and password used to access the call logging web 
interface. You can also enable or disable logging of internal calls as well as whether or not to update 
account balances even though balance is not enforced on accounts. This permits accounts to go into 
a negative balance. You can also manage the different PINs used by the system if any trunk lines have 
enabled call logging with PIN authentication. 
 



 
 

Jotron AS| Phontech 6200: Installation manual    Installation Page 2-55 

P/N: 87299 (v.D) 

 
Figure 48 - Phontech 6200 Storage Settings 

 
To add a new pin press the green plus icon and a dialog will appear. In this dialog you must enter the 
PIN and optionally a description of the PIN. The description can be changed by selecting the PIN in 
the list and clicking the notebook at next to the green plus icon. If you want to remove a PIN, click it 
and then click the red minus icon. 
 
If you delete a pin number the balance attached to this pin will be removed and cannot be restored 
unless you have an earlier backup from the web interface. 
 

 
Figure 49 - New PIN Dialog 

 
The web interface for the storage unit can be access by typing the IP address of the storage unit into 
the address bar of web browser. The address is shown in the drop down where you select the unit to 
use as your call logging storage device. 
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2.3.5.3 CALL LOGGING 
 
If a storage unit has been configured you can configure call logging on your trunk lines. See the 
"Configuring Storage" section above. 
 
To configure call logging on a trunk line, right click the trunk line in the left hand tree view and click 
"Properties". This will open the trunk line properties page. Go to the "Outgoing Call Method" tab and 
find the call logging options at the bottom of the page. There are a few different modes of call 
logging that can be enabled and they are as follows: 
 

 No  - This will not enable call logging on this trunk line 

 Extension based - This will base call logging and billing on the extension that calls the trunk 
line. When a user calls through the trunk line the number he was calling from is logged and 
any account balance updates are performed against an automatically created account that 
matches the phone that was called from. 

 Pin based - A PIN based call logging system will ask the user to input a PIN before he can call 
out on a trunk line. When a user dials the trunk line either by a dial out extension or a prefix 
or any other method he will be asked for the pin before the call goes out. If the user can 
enter a valid PIN, the call will be logged with this PIN number and any account updates will 
be to the PIN account that was entered. PIN numbers can be configured in the storage 
settings. See the "Configure Storage" section above for more information. 

 

 
Figure 50 - Trunk Line Properties Screen 

 
There are two other options that can be enabled in the call logging options page. If "Enable pre-paid 
billing meters" is checked, a user will only be able to make a call if the account he is associated with, 
either a PIN or the phone itself, must have a pre-paid balance. If the required balance is available, the 
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call will proceed as normal however it will only be able to run for as long as the user has available 
balance. 
 
The cost rates for different external extensions can be configured in the storage unit web interface. 
 
If "Delay billing by 20 seconds" is checked, then the user gets the first 20 seconds of a call for free. 
Depending on the technology that is used to connect the trunk line to the ICS 6200 system, it might 
be required to tick this to avoid unnecessary billed calls because the user in the other end did not 
pick up. Some systems indicate that they go off-hook before the other end actually has answered. 
 

2.3.5.4 CUSTOM SYSTEM SOUNDS 
 
The ICS 6200 system allows you to change some of the default sounds and notifications used in the 
system. To change these sounds you must go to the "Custom Sound Files" screen found under the 
"Tools" menu. 
 
Before any of the default sounds can be changed you must first upload some new sounds. This is 
done by clicking the "Add" button on the right side of the "Uploaded sound files" list. This will open a 
file dialog where you can select a sound file to upload. The sound file can be either a .wav file or an 
.mp3 file. For the best quality they should be in 8000 Hz Mono. When the file us uploaded it is 
transcoded to the internal format used in the ICS 6200 system. You can listen to the result of the 
transcode by clicking the newly uploaded file in the list and then click the "Play" button to the right 
of it. 
 
After one or more files have been uploaded they can be selected in the drop down boxes to the right 
of the page. This will change the sounds in question to the one you have selected. Uploaded sounds 
are also used in other parts of the application such as in the Trunk Line properties screen where you 
can select the sound that will play when a "Switchboard" configuration is used. 
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Figure 51 - Custom Sound Files Screen 

2.3.5.5 MODIFYING GLOBAL SNOM SETTINGS 
 
The global Snom settings dialog allows you to change the default settings for all the Snom 300 
telephones in your system. Under "General Options" it is possible to change the default tone scheme, 
clock format and ring tone. In the "Volumes" section you can change the volume on the ringer as well 
as the volumes of calls in speaker and handset mode. Under the "Other" section you can force the 
settings for all phones. This will disallow any user to change any of these settings on the phone itself. 
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Figure 52 - Changing Global Snom Settings 

2.3.5.6 MODIFYING GLOBAL UPN SETTINGS 
 
The global UpN settings dialog allows you to change the default settings for the UpN telephones in 
your system. 
It is possible to change the default ring tone, handset volume, speaker volume, paging volume and 
alert volume, as well as setting the default backlight level and the extensions reached by pressing M1 
through M3. 
 
The speed dial buttons M1 through M3 can operate in different modes, but only when the 
destination extension of a speed dial button is another digital UpN phone. The three modes of 
operations are: 
 

 Normal - The button works as a normal speed dial. The number is dialed as if it were entered 
manually on the key pad. 

 Intercom - The number is dialed and the other end automatically goes off-hook in an 
intercom state. This means that the sound will go out on the speaker on the other end and 
the external microphone will be enabled. The conversation will therefore go both ways until 
the call has been terminated. 

 Paging - The number is dialed and the other end will go off-hook in speaker mode but the 
microphone will not be enabled. This means that the call will only serve as a page that 
cannot be responded to without the performing another call. 

 
All the speed dial buttons can either be pushed once or held down. If the buttons are pushed the 
calls must be terminated by either by putting the handset back on-hook or pressing the ACT key. 
If the buttons are held down the call will automatically terminate once the button is released. 
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Figure 53 - Changing Global UpN Settings 

2.3.5.7 CONFIGURING CONFERENCE ROOMS 
 
Conference Rooms are special extensions where multiple users may engage in conversations 
together. The Conference Configuration dialog allows you to enable conference rooms and configure 
the extension used to dial to the conference rooms. 

 
Figure 54 - Locating the Conference Config Dialog 
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Figure 55 - Enabling Conference Rooms 

2.3.5.8 UPGRADING FIRMWARE 
 
It is possible to upgrade the firmware of Phontech 6200 units by using the Phontech 6200 
Configuration Application and a new firmware file as supplied by Jotron. You can upgrade the 
firmware of specific Phontech 6200 units by right clicking on the unit in question in the lower left 
corner of the application and selecting "Upgrade Firmware". However, in cases where you have more 
extensive systems with several 6200 units, it is easier to use the "Update System Firmware" dialog, as 
found under the "Tools"-menu. 

 
Figure 56 - The Update Firmware Tool 

 
Upon opening either of these two options, you will be asked to find the new firmware file. Once this 
has been done, the application will check that the new firmware is valid and present you with the 
version and build date of both the current firmware and the newly selected firmware. 
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If this information looks valid, press "Ok" to send the new firmware to your 6200 unit(s). The 
firmware will be checked for correctness on the Phontech 6200 unit upon receiving it, prior to 
extracting it. The process will take a few minutes and the Phontech 6200 unit(s) will reboot upon 
completing it. 

 
Figure 57 - Information about Current and New Firmware 

 

2.3.5.9 RENAME ICS 
 
If it is desired, it is possible to change the identifier of each unit in the Phontech 6200 system. This 
identifier will be displayed in the visual representation of the Phontech 6200 network and in the 
printed extension layout. To rename a 6200 unit, right click on the unit in question in the lower left 
corner of the application and select "Rename ICS". 
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Figure 58 - Renaming a Phontech 6200 Unit 

 

2.3.5.10 MIGRATE CONFIGURATION TO ANOTHER SYSTEM 
 
Sometimes it can be useful to use the same configuration on multiple systems. To achieve this, the 
configuration must be migrated from one system to another. We will call the previous system A and 
the new system B. 
 
The first step is to save the configuration of system A to a file a computer. After the configuration is 
saved the computer must be connected to system B. While the computer is connected to system B, 
load up the configuration from system A and enter the "Migrate Configuration" wizard from the 
Tools menu. 
 

 
Figure 59 - Migrate Configuration Wizard Menu Item 
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In the Migrate Configuration wizard you are presented with the view of the current system as well as 
the view of the system in the loaded configuration. The system in the configuration can be seen 
under "Configured ICSes" and the connected system can be found under "Unassigned discovered 
ICSes". The lists in both views display the IP addresses of the units as well as the modules that are or 
have been inserted in them. 
 

 
Figure 60 - Unassigned ICSes in Migrate Configuration 

 
If the configured and discovered systems are identical in the module configuration you can press the 
"Auto assign" button found between the two views. This will try to automatically match the modules 
of the configured ICSes and the discovered ones so they map up perfectly. 
 
If the modules does not match, but you still want to use the configuration anyways you must 
manually assign which discovered ICS in system B that should take over the role of a configured ICS in 
system A. To do this you first click the discovered ICS in the bottom view and then click the 
configured ICS you want it to take the role of in the top view and then click the "Assign selected ICS" 
button to assign it. The selected discovered ICS should then disappear from the bottom view. Do this 
for all configured Phontech 6200 Units. 
 
Only Phontech 6200 units of the same type can be assigned to each other. 
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Figure 61 - Assigned ICSes in Migrate Configuration 

 
Once all configured Phontech 6200 units have been assigned a discovered ICS you can click "Finish" 
to perform the migration. After the migration is done the configuration can be sent to the system as 
normal. 

2.3.6 TROUBLESHOOTING 
 
In the case that you run into some trouble, this section contains some pointers on how to get some 
help and how to troubleshoot basic issues. 
 

2.3.6.1 STARTING FROM SCRATCH WITH A NEW CONFIGURATION 
 
If the configuration you have created does not fit as well as anticipated, it may be easier to restart 
from scratch. This may be done using the "New Configuration" function, which will present you with 
a pristine starting point so you can try again. Remember to send the configuration if you want to 
reset the configuration of the Phontech 6200 network too. 
 

2.3.6.2 UNABLE TO SEND CONFIGURATION DUE TO LICENSE ERROR 
 
If you get the error message below when you try to send the configuration that means that the 
installed license either does not validate or does not provide enough licenses for the amount of SIP 
or Snom 300 phones configured in the system. 
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Figure 62 - License Error during Send Configuration 

 
For the license to validate correctly, all of the Phontech 6200 units in the system must be powered 
on and connected to the network. This can be verified by inspecting the list of Phontech 6200 units in 
the lower left corner of the Configuration Application and see that all the status icons are green. 
 
If the license is not valid for the given system or the number of SIP telephones in use, you can 
request a new license from "Help -> Request License Quote" as explained in the "SIP Licenses" 
chapter. 
 
 

2.3.6.3 REVERT TO KNOWN GOOD 
 
If you created a known good fallback previously, it is possible to restore that state by using the front 
panel display of the Phontech 6200 unit. Please consult the Phontech 6200 Firmware documentation 
for instructions on how to perform this operation. 
 

2.3.6.4 FACTORY RESET 
 
This function will revert the Phontech 6200 unit to its factory state, and remove all configuration, 
databases and settings contained on the Phontech 6200 unit. It is possible to perform this using the 
front panel display of the Phontech 6200 unit. 
Once this has been performed, the Phontech 6200 unit reverts to its factory defaults. This means 
that you will have to run through the first run wizard again. Please consult the Phontech 6200 
Firmware documentation for instructions on how to perform this operation. 
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2.3.6.5 CHOOSE NETWORK INTERFACE 
 

 
Figure 63 - Network Configuration Location 

 
This function can be useful if you have multiple network interfaces connected to different networks. 
This may cause the configuration application to not be able to discover your Phontech 6200 network. 
The dialog present under "Tools -> Network Configuration" allows you manually select the correct 
network interface. By doing this, you will instruct the Phontech 6200 Configuration Application to 
send discovery requests to the correct network instead of the more generic fallback. 
This setting is stored across restarts of the application. The default value is the "Any"-setting. 
 

 
Figure 64 - Setting a Network Interface 

 

2.3.6.6 CREATING AN INFORMATION PACKAGE 
 
If you require additional support for your Phontech 6200 System, please enclose an Information 
Package with your support request. The Information Package can be created using the "Help -> Info" 
dialog, simply press the "Export Information" button. This will create a single file containing logs from 
the application and any Phontech 6200 unit in the network, the configurations of each unit and 
information concerning the software versions used for the Configuration Application and each 
Phontech 6200 unit. 
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Figure 65 - Information Window 

2.3.6.7 LIST OF ALLOWED SEPARATORS IN NAMES 
 
It is possible to use alphanumeric characters for names in the configuration application, in addition to 
the following separators: 
- '-' (hyphen) 
- ',' (comma) 
- '.' (period) 
- '+' (plus) 
- '&' (ampersand) 
- '#' (hash) 
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2.4 FRONT PANEL MANUAL 

2.4.1 LED INDICATIONS 
 
There are three LEDs found on the left side of the Phontech 6200 unit, providing different 
information. From top to bottom, they are the power LED, the info LED and the error LED. 
 

 
Figure 66 - Phontech 6200 Front View 

 
The power LED will either be red or green, depending on the power supply status of the unit. If both 
power supplies are active, the LED will be green. If one of the supplies is down, the LED will be red. 
The info LED will show a heartbeat when the unit is running. The frequency of the heartbeat may give 
you an indication of the relative load of the unit. The error LED will light up if an error has been 
detected. More information regarding the type of error can be seen in the Information-menu. 

2.4.2 FRONT PANEL DISPLAY 
 
The front panel display provides navigation buttons on the left side, an LCD-screen for displaying 
information and a cancel and enter button on the right hand side. The front panel also includes a 
reset button which may be reached by using a safety pin or a similar instrument. 

 
Figure 67 - Phontech 6200 Display and Buttons 

2.4.3 FIRST RUN WIZARD 
 
Unless the 6200 has been set up previously, it will run a first time setup wizard when powered on. 
This wizard will allow you to set the time and date, as well as choose if the 6200 shall be a new one 
or a replacement for another. 

 
Figure 68 - First Step of the First Run Wizard 

 
Figure 69 - Adjusting Clock and Date in the First Run Wizard 
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Figure 70 - Entering the Time in the First Run Wizard 

 
Figure 71 - Entering the Date in the First Run Wizard 

 
If the 6200 is a new 6200, you must select which number it is. The number shall be unique in a given 
6200 network, and the first 6200 in a given network must be numbered 1. 
 

 
Figure 72 - Is This a Replacement or a New Unit? 

 
Figure 73 - Select the Number for this Phontech 6200 Unit 

 
If the 6200 is a replacement for a previous 6200, you may select which 6200 it is a replacement for 
among the ones currently missing. Please note that the replacement 6200 must have the same line 
modules installed. If this is not the case, the wizard will warn you, but you may still complete it and 
reconfigure the unit at your convenience. Once the wizard is completed, the unit will reboot, and can 
be configured and used. 
 

2.4.4 MENUS 
 
When running, the display will show the Jotron logo by default. When this is shown, pressing any of 
the buttons on the unit will show the menu system. 

 
Figure 74 - The Jotron Logo, the Default View 

 
You may navigate through the menu system by using the up and down buttons. Enter will select or 
activate the currently chosen entry, while cancel will go back to the previously selected entry in the 
menu. Use the left and right buttons to select different options found on the same screen. 
 
The PBX units have all the menus mentioned in these chapters while the Storage units only have the 
“Information” and “Setup” menus described in chapters 2.4.4.5 and 2.4.4.6 respectively. 
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2.4.4.1  MODULE OVERVIEW 
 

 
Figure 75 - Module Overview 

 
This screen gives a quick overview of the current state of the line modules installed. If any UpN 
modules are installed, it is possible to see which ports on the front that have telephones connected. 
 

2.4.4.2 MODULES 
 

 
Figure 76 - Modules Menu 

 
Figure 77 - Viewing a Specific Module Position 

 
This screen gives more in-depth information about each of the line modules installed, such as the 
type of module, the position it is installed in, and which ports on the front correspond to the module 
in question. It is also possible to select individual modules in order to see the extension (if any) that 
have been assigned to that particular port. 

 
Figure 78 - Extension for Port 1 

 

2.4.4.3 SNOM 
 

 
Figure 79 - Snom Menu 

 
The Snom menu allows you to see the Snom telephones configured on this Phontech 6200 unit. It 
will show you the extension the Snom telephones are registered under, if the phone has registered 
and the MAC-address of the phone. 
 

2.4.4.4 SIP 
 

 
Figure 80 - SIP Menu 
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Figure 81 - Viewing a SIP Extension 

 
The SIP menu allows you to see the SIP telephones configured on this Phontech 6200 unit. It will 
show you the extension the SIP telephones are registered under and if the phone is currently 
registered. 
 

2.4.4.5 INFORMATION 
 

 
Figure 82 - Information Menu 

 
The information menu contains different options which allow you to view information concerning 
the current state of this Phontech 6200 unit. 
 

2.4.4.5.1 Number and IP  
 

 
Figure 83 - Number and IP Menu 

 
Figure 84 - Viewing the Number and IP of this Phontech 6200 

 
The number and IP menu will display which 6200 this is and its IP address. 
 

2.4.4.5.2 Error Information 
 

  
Figure 85 - Error Information Menu 

 
Figure 86 - Viewing an Error – the Fan Speed is Below the Threshold 

 
The Error Information menu provides a human-readable explanation of errors found in the system, if 
any. Multiple errors may be displayed and navigated through by using the Up and Down buttons. 
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2.4.4.5.3  Version 
 

 
Figure 87 - Version Menu 

 
Figure 88 - Viewing the Firmware Version 

 
The Version menu provides the version and build date of the currently running firmware on this 
Phontech 6200 unit. 
 

2.4.4.6 SETUP 
 

2.4.4.6.1 Adjust Clock and Date 
 

  
Figure 89 - Adjust Clock and Date Menu 

 

 
Figure 90 - Adjust Clock 

 
Figure 91 - Adjust Date 

 
The Adjust Clock and Date menu allows you to change the time and date on this Phontech 6200 unit.  

2.4.4.6.2 Mark as Good 
 

 
Figure 92 - Mark as Good Menu 

 
Figure 93 - Selecting the Mark as Good Menu 
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The Mark as Good menu allows you to take a copy of the currently running firmware and 
configuration and store it as a "Known Good" image in a separate part of the unit. This firmware and 
configuration can then be restored using the "Revert to Known Good"-menu at a later date. If you 
choose to create a new "Known Good" image using the "Mark as Good" menu, the 6200 will reboot, 
and make a copy of the firmware and configuration. After this has completed, the 6200 unit will 
reboot into the regular firmware. 
 

2.4.4.6.3 FXO Tuning 
 

  
Figure 94 - FXO Tuning Menu 

 
Note: This sub menu is not available on the Storage units as they do not have any line modules. 
 
The FXO Tuning menu allows you to automatically tune several parameters related to the FXO 
modules installed in your system. The tuning procedure is designed to help you reduce or eliminate 
unwanted echo that may occur when connecting to other telephony systems. Please note that the 
tuning procedure will cut off ongoing calls on the unit. 
To start the tuning procedure, select the "FXO tuning" option. In order for the tuning procedure to 
work, you must supply a digit which will clear the dial-tone on the unit at the other end. 

 
Figure 95 - Entering a single digit to stop the dial tone 

 
The tuning procedure will tune each port of every FXO module that is installed in the Phontech 6200 
unit. This process will take a few minutes. After it has completed, the Phontech 6200 unit will reboot, 
and the freshly tuned parameters will be applied. 

 
Figure 96 - Tuning in Progress 

 

2.4.4.6.4 Factory Reset 
 

 
Figure 97 - Factory Reset Menu 

 
Figure 98 - Selecting the Factory Reset Menu 

The Factory Reset function allows you to discard all configuration data and settings stored on the 
6200 and restore it to a pristine factory state. Once this has been performed, the Phontech 6200 unit 
will reboot, and present you with the first run setup wizard. 
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2.4.4.6.5 Revert to Known Good 
 

  
Figure 99 - Revert to Known Good Menu 

 
Figure 100 - Selecting the Revert to Known Good Menu 

 
The Revert to Known Good function allows you to return to a previously set Known Good checkpoint 
or, if no such point has been created, to the factory defaults. Upon running this function, the 
Phontech 6200 unit will reboot and perform the rollback operation. This will take a few minutes. 
Once this has been completed, the Phontech 6200 unit will reboot again into the Known Good 
checkpoint. A Known Good checkpoint may be restored multiple times. 
 

2.4.4.6.6 Reboot 
 

  
Figure 101 - Reboot Menu 

 
Figure 102 - Selecting the Reboot Menu 

 
The Reboot function allows you to reboot the Phontech 6200 unit. After the Reboot operation, the 
Phontech 6200 unit will return to its regular state.  
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2.5 CALL LOGGING WEB INTERFACE 
 

2.5.1 LOGGING ON TO THE CALL LOGGING WEB INTERFACE 
 
The call logging interface can be reached through any modern web browser. First we must locate the 
address of the storage unit that is currently used for call logging. This address can be found under the 
Phontech 6200 Storage Settings that is described in chapter 0. The address we are looking for can be 
found in the “Call logging unit” dropdown box as seen on the picture below. 
 

 
Figure 103 - Location of Selected Storage Unit 

 
You can also find the address of the call logging unit by looking in the Information menu on the front 
panel display on the physical unit. Click any of the navigation buttons to clear the ‘Jotron’ logo and 
click the ‘Enter’ button when you are at the ‘Information’ menu item. Then click ‘Enter’ again on the 
‘Number and IP’ item. The address will now be displayed on the screen. This is also described in 
chapter 2.4.4.5. 
 
Once we have found the address we can access the call logging web interface by entering this 
address into a modern web browser. You will be greeted with a username and password prompt 
where you have to enter the username and password that has been configured in the Phontech 6200 
Storage Settings. The default username and password are both “admin”. 
 
If the correct username and password has been entered, you will be directed to the welcome screen 
for the web interface as shown below. 
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Figure 104 - Phontech 6200 Call Logging Web Interface 

 
This page displays a short description of the different pages that can be accessed on in the web 
interface.  
 

2.5.2 USERS / PINS PAGE 
 
The Users / PINs page displays a list of all the users and PINs in the system.  This is also the gateway 
to see call records for individual users or PINs.  
 

2.5.2.1 USERS 
The first part of the page lists all the users (a user is a single extension) that are configured on the 
system as well as the balance on their current account. The list can be navigated in by either using 
the search box in the top right of the list or by using the arrows or page numbers at the bottom right 
of the list. 
 
All of the users in the user list are automatically configured when users are added or removed 
through the configuration application for the entire system. It is not possible to add or remove users 
by other means. The user balances are updated automatically if trunk lines on the system are 
configured to use extension based balance tracking.  
 
The right-most column in the user list is a button that will reset the given user’s balance back to 0. At 
the bottom of the table there’s a button that will reset all of the users’ balances with a single click. 
 
To see detailed call reports for a single user, click on the extension for that particular user. This will 
open the page for this individual user which is further explained in chapter 2.5.3. 



 
 

Jotron AS| Phontech 6200: Installation manual    Installation Page 2-78 

P/N: 87299 (v.D) 

 
Figure 105 - Users / Pins page - Users Part 

 

2.5.2.2 PINS 
 
Below the user list, we find the PINs section. This lists all of the PINs that have been configured for 
the system. These PINs must be configured from the configuration application as described in 
chapter 0. This list can be navigated in the same way as the user list by either searching in the upper 
right corner or using the page numbers and buttons at the bottom right corner of the list. 
 
The PINs list contains a button in the right-most column that will reset the balance back to 0 for the 
given PIN. At the bottom of the table there’s a button that will reset the balance of all PINs with a 
single click. 
 
To see the detailed call log for a given PIN click on the PIN number in the left most column. This will 
show the individual PIN page which is further explained in chapter 2.5.3. 
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Figure 106 - Users / Pins page – PINs and Export/Import 

 

2.5.2.3 EXPORT OF USERS AND PINS 
 
The export options are located the bottom of the Users / PINs page as seen in Figure 106. You can 
either export a list of current user balances or a list of current PIN balances. The list to export can be 
selected with the “Users” and “Pins” buttons in the Export section. The balances can be exported as 
PDF, XML or comma separated values (CSV) by clicking the corresponding button in the Export 
section. When the button is clicked, a download dialog with the selected format will appear and you 
can select where to save the exported data. 
 

2.5.2.4 IMPORT OF BALANCES 
 
It is also possible to import balances into the call logging system. By clicking the “Import XML” button 
in the Import section you will be presented with an open file dialog where you can select the file with 
the balances to import. The format of the file must be XML and in the same format as given by the 
“Export XML” button. Note that this will change the balances of all the users and pins that are 
located in the import file. This operation cannot be undone. 
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2.5.3 INDIVIDUAL USER AND PIN PAGES 

2.5.3.1 USER PAGE 
 
The detailed user page displays the detailed call logs for a given user.  The current balance of the user 
is displayed at the top of the page. 
 
The list will show all calls made by this user, sorted by date. The list can be navigated with the 
previous and next buttons at the bottom right of the list.  
 

 
Figure 107 - Details for User 101 

 
The columns in the call log are as follows: 

 Date/Time - The date and time when the call was initiated 

 Source -The user that initiated the call. This will always be the user we are looking at. 

 Destination - The number that was dialed. 

 External - The actual number that was dialed over the trunk line. 

 Duration- The number of seconds the user was in the call. 

 Billed - The number of seconds that should be billed for the call. This does not include the 
time taken by the user to dial or enter a pin number. 
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 Cost - The cost of the call. This is calculated by multiplying the billed seconds by the correct 
rate for the destination. 

 Type - The type of record. This can either be ‘Billing’ or ‘Documentation’. Note that calls 
marked as ‘Documentation’ will have billing seconds set to 0 as they are only present to 
document the call, not bill it. Those calls include calls between users inside the system and 
incoming calls if enabled through the Phontech 6200 Storage Configuration. 
 

Under the call log list there’s a filter button so you can change if the log should display billed calls 
only or include the documentation lines as well. By default it will only display the billed calls. 
 
At the bottom of the page we have the export functions. Here you can export a report with the calls 
that this user has made. There are two pre-determined and one customizable option for the report 
period.  

 Previous month - This will take the previous month and generate a report of all the calls for 
that month. If the current month is September, it will generate a report from 1st of August to 
the 31st of August. 

 One month prior - This option will take us one month back from the current month. So if the 
current date is 15th of September it will generate a report from the 15th of August to the 15th 
of September. 

 Custom - If none of the two other options match you can choose this to input a start and end 
date manually. 

 
For the two pre-determined options you can always see the report dates that will be used in the 
input boxes underneath the options. These will change as the different options are selected. 
 
To actually export the report you have to click on one of the three export buttons at the bottom to 
choose the format which you want for your report. The available formats are “PDF”, “XML” and 
“CSV” (comma separated values).  

2.5.3.2 PIN PAGE 
 
The pin page is very similar to the User page described in chapter 2.5.3.1. The call log list is the same 
as in the User page, but note that it now displays all calls where the selected PIN number has been 
used. This means that the Source field will not always be the same as the PIN number could have 
been used from multiple phones. The balance associated with the PIN can be found at the top of the 
page. 
 
The export functions for the PIN is the same as for the users. Choose the period for the report and 
click the format button of your choice and you will be presented with a download dialog for the 
report. 
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2.5.4 REPORTS PAGE 
 
The reports page will show all call records logged by the system. The records are sorted by date. The 
list can be navigated with the buttons in the bottom right corner of the list. 
 
The columns in the call log are as follows: 

 Date/Time - The date and time when the call was initiated 

 Source -The user that initiated the call. 

 Destination - The number that was dialed. 

 External - The actual number that was dialed over the trunk line. 

 Duration- The number of seconds the user was in the call. 

 Billed - The number of seconds that should be billed for the call. This does not include the 
time taken by the user to dial or enter a pin number. 

 Cost - The cost of the call. This is calculated by multiplying the billed seconds by the correct 
rate for the destination. 

 Type - The type of record. This can either be ‘Billing’ or ‘Documentation’. Note that calls 
marked as ‘Documentation’ will have billing seconds set to 0 as they are only present to 
document the call, not bill it. Those calls include calls between users inside the system and 
incoming calls if enabled through the Phontech 6200 Storage Configuration. 

 Pin - If a PIN was used, it will be displayed in this column. 
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Figure 108 - Reports Page 

 
The list will by default only show billed entries. If you want to see all the logged calls you can change 
this setting by clicking the ‘All records’ button underneath the list. 
 
The export functions work the same way as the export described in chapter 2.5.3.1 and 2.5.3.2. 
Select the period you want a report for and click one of the buttons at the bottom to get the 
exported report in the desired format. 

2.5.5 PAYMENT PAGE 
 
The payment page is used to add credits to user and PIN accounts. To add to the balance of a user or 
a PIN, select the desired one from the two lists on this page by clicking the check boxes in the left-
most column. After the user or PIN has been selected you can enter the number of credits that you 
want to add in the 'Amount to add' spin box at the bottom of the page. Click the 'Process' button to 
finish the balance update. Multiple users and pins can be updated in a single action by selecting 
additional users or PINs from the lists. The lists can both be navigated with the buttons and page 
numbers at the bottom right of each list and the selections from previous pages will remain active as 
a new page is viewed. The search box in the top left of each list can also be used to filter the lists.  
 
If pre-paid billing meters are active on trunk lines the users and/or PINs in use must have a positive 
balance equal to that of at least 1 minute worth before they can be used to access a trunk line. 
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Figure 109 - Payment Page 

2.5.6 BILLING RATES PAGE 
 
The billing rates page is where we can configure the cost rates for numbers dialed over trunk lines. 
You can match explicit numbers or create patterns for matching number ranges.  The currently 
configured billing rates can be found in the list at the top of this page. The list can be navigated with 
the buttons and page numbers in the bottom right corner of the list.  
 
To remove a configured rate, select it by clicking the check box in the left-most column next to the 
rate you want to remove and then click the ‘Delete selected’ button. Multiple rates can be selected 
for one delete operation. 
 
Note that any change to the configured rates will not affect already logged calls. Only new calls made 
after the change to the rates will be affected.  
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Figure 110 - Billing Rates Page 

 
The ‘default’ rate will be used when no other billing rate can be matched. By default it is set to 1 
credits pr. minute, but it can be changed by entering ‘default’ as the pattern when you add a new 
rate. 
 
To add a new rate you enter the pattern you want to match in the ‘Pattern’ input box in the ‘Add 
billing rate’ section. You then enter the desired rate in the box below it. This rate will be the cost of a 
call pr. minute.  
 
If you want to match a single number simply enter the number in the pattern field. If you want to 
match multiple numbers, such as a prefix or a range of numbers you have to use the pattern 
matching approach. Patterns can be created using the ‘X’ and ‘_’ characters. Entering ‘X’ will match 
any number, while ‘_’ will allow the previous number or match to be repeated multiple times. This 
may be used to match numbers of arbitrary lengths. Some examples are shown below. 
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Examples 

 To match the numbers 100-199 the expression 1XX can be used. 

 To match any numbers starting with 0047 followed by more numbers the expression 0047X_ 
can be used. 

 To match any number that starts with a one and is at least 3 digits long you can use the 
pattern '1X_'. 

 
The billing rates can be exported in XML and CSV format by clicking on one of the export buttons at 
the bottom of the page. Rates can also be imported from files in the same XML format as the 
exported XML format. The import function will only add additional or change existing rates. It will not 
delete any configured billing rates. 
 

2.5.7 SETTINGS PAGE 
 
In the ‘Settings’ page you can get an overview of the system as well as perform backup and 
maintenance. You can see the number of records still available for storage in the system as well as 
the current firmware version.  
 

 
Figure 111 - Settings Page 

 
To free storage space, it is possible to remove older records stored in the system. This is done by 
specifying a date that you want to purge records from in the ‘Maintenance’ section. When you have 
picked a date and clicked the ‘Delete’ button it will delete all records that are older than the given 
date. Note that this operation is irreversible. 
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The backup and restore functions will export any rates, settings and balances into a file that can later 
be restored by the ‘Restore’ function. The actual call records are not stored in the file and cannot be 
restored later. 
 
You can also perform a factory reset by clicking the ‘Factory reset’ button at the bottom of the page. 
This will delete all information visible in the web interface such as billing rates, balances and call 
records. 
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3 WALL MOUNTED ENCLOSURES AND TYPICAL CONFIGURATIONS 
  

3.1 6203 6U ENCLOSURE 
 
6203 6U wall mount enclosure complete with rails and terminals. Will accommodate up to 2 
Phontech 6200 and two patch panels. A typical configuration is displayed below, 6203 with two 
Phontech 6200 units. The enclosure comes with a transparent protective front cover. Cable entry in 
the bottom. This enclosure is limited to low weight units, and is typically used for PABX only 
applications. 

 

 
 
 

6203 Terminal arrangement 
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Drill template 6203 
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3.2 6204 18U ENCLOSURE 
 
6204 18U wall mount enclosure complete with rails and terminals. Similar to 6203. Transparent 
protective front cover.  Cable entry in the bottom. Used for larger PABX installations. A typical 
configuration is displayed below, accommodating  6 Phontech 6200 units. 
 

 



 
 

Jotron AS| Phontech 6200: Installation manual    Wall mounted enclosures 
and typical configurations 

Page 3-91 

P/N: 87299 (v.D) 

3.3 15U PABX/PA/GA COMBINATION ENCLOSURE 
Three-part 15U wall-mounted enclosure.  When combining the PABX with PA/GA equipment or amplifiers 
this enclosure style is used. Solid top and cable entry brush insert at bottom. 
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4 INTERCOM UNITS 
 

4.1 GENERAL CONFIGUTRAION INFORMATION 
 
All intercom units (DICS 6111, 6112, 6113, 6114, 6123 and 6124) are equipped with an internal DIP-
Switch block containing 8 switches. These configure some individual settings for each unit: 
 

DIP Sw Description 

1 Activate Backlight DIMMER function in the DICS 6123 

2 For future use 

3 For future use 

4 Disable OFF HOOK sensor (ACT key is the only way to activate the unit) 

5 For future use 

6 For future use 

7 For future use 

8 For future use 

4.2 DICS 6110 ACCOMODATION UNIT 
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- Built- in WP loudspeaker. 
- Hands free, duplex communication. 
- Privacy switch. 
- Telecom standard alphanumeric keypad. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- 3 direct access programmable keys. (M1-M2-M3) 
- 10 pcs. accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Connection: One Pair – line feed 
- Desk or bulkhead mounted. 
-  
Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
Sound pressure level  80dBA@1m typical 
Weight   1.0 kg 
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External connections DICS 6110 
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4.3 DICS 6111, WP UNIT WITH HANDSET 

 
- Bulkhead mounted. 
- Output for external loudspeaker. 
- Hands free (requiring external loudspeaker), duplex communication. 
- Telecom standard alphanumeric keypad. 
- Rugged handset of WP type. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- Direct access programmable keys. (M1-M2-M3) 
- 10 pcs. accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Call signal relay. (For external signal organ, flashlight, siren etc.) 
- Connection: 

o Handset only: One Pair – line feed connection 
o External loudspeaker or relay for external signal device: Line + 24V DC 
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Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
 
External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 
 Impedance 20 ohms 
 
External signal organ current capabilities: 
   24 VDC: max. 5A 
   115 VAC: max. 6,3A 
   220 VAC: max. 5A 
Weight   1.0 kg. 
Ingress protection IP 65 

 

4.4 DICS 6112 WEATHERPROOF UNIT 
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- Bulkhead mounted. 
- For external loudspeaker. 
- Hands free (requiring external loudspeaker), duplex communication. 
- Telecom standard alphanumeric keypad. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- Three direct access programmable keys. (M1-M2-M3) 
- 10 accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Call signal relay. (For external signal organ, flashlight, siren etc.) 
- Connection: 

o Line 
o 24V DC 

 
Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
 
External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 
 Impedance 20 ohms 
 
External signal organ current capabilities: 
   24 VDC: max. 5A 
   115 VAC: max. 6,3A 
   220 VAC: max. 5A 
Weight   1.0 kg. 
Ingress protection IP 65 
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External connections DICS 6111/6112 

 
 



 
 

Jotron AS| Phontech 6200: Installation manual    Intercom units Page 4-99 

P/N: 87299 (v.D) 

4.5 DICS 6113 AND DICS 6123 FLUSHMOUNTING UNIT 

 
- Flush-mounting. 
- Built-in WP loudspeaker. 
- Output for external loudspeaker. 
- Hands free, duplex communication. 
- Telecom standard alphanumeric keypad. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- Three direct access programmable keys. (M1-M2-M3) 
- 10 accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Call signal relay. (for external signal organ, flashlight, siren etc.) 
- DICS 6123 only; backlighting with dimmer. 
- Connections: 

o Handset only: One Pair – line feed connection 
o External loudspeaker or relay for external signal device: Line + 24V DC 
o DICS 6123 Backlight: Line + 24V DC 

 
Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
Sound pressure level  80dBA@1m typical 
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Backlight dimmer 5 steps : 10mLux – 1 Lux 
 
External loudspeaker and relay function requires an additional power input. 
Power requirement, additional input 
1A/24VDC 
External loudspeaker: 
Max power 10W 
 Impedance 20 ohms 
 
External signal organ current capabilities: 
   24 VDC: max. 5A 
   115 VAC: max. 6,3A 
   220 VAC: max. 5A 
Weight   1.5 kg. 
Ingress protection IP 44 
 
External connections DICS6113/6123 

 



 
 

Jotron AS| Phontech 6200: Installation manual    Intercom units Page 4-
101 

P/N: 87299 (v.D) 

4.6 DICS 6114 WP PORTABLE UNIT 

 
- Built-in WP loudspeaker. 
- Internal microphone. 
- Duplex communication. 
- Telecom standard alphanumeric keypad. 
- 10 m. cable and connector. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- Three direct access programmable keys. (M1-M2-M3) 
- 10 accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Connection: Pluggable one pair – line feed 
- Bulkhead mounting. 
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Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
 
Weight   1.5 kg. 
Ingress protection IP 65 
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4.7 DICS 6124 WP BULKHEAD UNIT 

 
- Built-in WP loudspeaker. 
- Internal microphone. 
- Duplex communication. 
- Telecom standard alphanumeric keypad. 
- 10 m. cable and connector. 
- Manual PTT (push-to-talk) key. 
- ACT key. (line active) 
- Three direct access programmable keys. (M1-M2-M3) 
- 10 accessible programmable keys. (0-9) 
- Volume control key (VOL) with override (important message priority) 
- Program key. (P) 
- Connection: Pluggable one pair – line feed 
- Bulkhead mounting 
 

Operation voltage 37VDC provided by line 
Current drain  70 mA max, provided by line 
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Weight   1.5 kg. 
Ingress protection IP 65 

 

4.8 TYPE 9011 PLUGBOX (FOR DICS 6114) 

 
- Receptacle with cover. 
- Rugged plastic box. 
- Bulkhead mounting 

 
  



 
 

Jotron AS| Phontech 6200: Installation manual    Intercom units Page 4-
105 

P/N: 87299 (v.D) 

External connections DICS 6114/6114 and 9011 
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4.9 TYPE 6035 HEADSET WITH HOOKSWITCH  

 
For use with 5111-H and 6112 

- High comfort headset with boom microphone and hook-switch. 
- Excellent attenuation at low and high frequencies with maximum comfort for continuous 

use. 
- Ideal in severe noise environments. 
- Folds to compact size for easy storage. 
- 10 meter cable. 
- Noise cancelling microphone. 
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5 ANALOG TELEPHONES 

5.1 EUROSET 5005 

 
- DTMF analogue telephone 
- Name keys 
- 10 speed dial  
- Redial key 
- Mute key 
- Desk / Wall mounting 
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5.2 FEP 2010 FLUSHMOUNTING TELEPHONE 

 
- DTMF analogue telephone 
- Telecom standard keypad 
- R-key (flash) 
- Backlight (optional) 
- Call signal relay (for external signal organ, flashlight siren etc.) (optional) 
- Flush mounting 
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5.3 DICS 5113/5123 FLUSHMOUNTING TELEPHONE 

 
- DTMF analogue telephone 
- Loudspeaking/handset operation 
- 3 Speed dial keys 
- Relay for external signal device Max 5A 
- Ext. loudspeaker connection 
- Console flush mounting 
- IEC 60945 Approved 
- 5123 only: Backlight /dimmer control 
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5.4 DICS 5111. FERNTEL 3 RUGGED INDUSTRIAL TYPE TELEPHONE 

 
 

- Housing: Polycarbonate / Colour: Black 
- Handset retaining mechanism 
- Protection degree: IP65/IEC 529 
- Receiver volume can be boosted by 6 or 12 dB(A) 
- Ringer output: approx. 96 dB(A) at 1 m distance 
- Temperature range: -25°C up to +60°C 
- Desktop or bulkhead mounting 
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5.5 DICS 5111-H WITH HEADSET INTERFACE 

 
 

- Housing: Polycarbonate / Colour: Black 
- Handset retaining mechanism 
- Protection degree: IP65/IEC 529 
- Receiver volume can be boosted by 6 or 12 dB(A) 
- Ringer output: approx. 96 dB(A) at 1 m distance 
- Temperature range: -25°C up to +60°C 
- Desktop or bulkhead mounting 
- Connection for 6035 headset 
- 24VDC power supply required 
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5.6 EX RESISTTEL TELEPHONE FOR HAZARDOUS AREAS 

 
Bulkhead mounting 
- Types of protection: 

o II 2 G EEx em[ib] IIC T5 / II 2 D IP66 T100°C / -25°C<=Ta<=60°C 
o II 2 G EEx em[ib] IIC T6 / II 2 D IP66 T80°C / -25°C<=Ta<=40°C 

- Housing Glass fibre reinforced polyester 
- Certified for dust and gas atmospheres 
- Display 2 lines; alphanumerical / multiple languages 
- Telephone directory 
- Hands free operation 
- Impact protection IK 09 
- Integrated adjustable stabilizer bracket 
- Operations temperature -25°C to +60°C 
- Adjustable receiver volume (7 steps) 
- Max audio level approx. 90 dB(A) 
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- Stainless steel (V4A) keypad and steel armored handset cord with snap-protection 

6 IP TELEPHONES  

6.1 SNOM 300 

 
Basic office IP telephone 
- Two line display 
- Caller ID (Name / Number) 
- Programmable function keys 
- Hands free operation 
- 2 Eth ports (internal switch) 
- PoE / External supply 
- SIP Client 
- Headset connection 
- Intercom operation 
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6.2 FERNTEL IP  

 
Industrial Phone for Indoor and Outdoor Environments, IP 65 
- Display 
- Caller ID (Name / Number) 
- Caller ID (Name / Number) 
- SIP client 
- Desk / Wall mounting 
- PoE / External supply 
 
- Comes in  Ex approved type (Zone 2/22) 
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6.3 RESISTTEL IP 

 
Industrial Phone for Indoor and Outdoor Environments, IP 66 
- Display 
- SIP client 
- Hands free operation 
- 2 Eth ports (internal switch) 
- Desk / Wall mounting 
- PoE / External supply 
- Optional Relay output 
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7 NETWORKING EQUIPMENT 

7.1  SF-300  

 
24 port Ethernet switch with PoE 
 
The SF-300 Ethernet switch with Power over Ethernet is required for the connection of IP telephones. 
Connect the IP telephones to the SF-300 switch using Cat5e patch panels. The SF-300 is in turn 
connected to the Phontech 6200’s Ethernet connection. Power is supplied from the switch to the IP 
telephones over the Ethernet cable. 
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8 ACCESSORIES 
 

8.1 50 PORT TELEPHONY PATCH PANEL 
 
The 50 port Cat3 patch panel can be used when connecting FXS, FXO, UPN and E&M lines to the 
Phontech 6200 when structured cabling is used in the installation. This drawer style patch panel 
allows for easy access during termination of the field cable. 

 

8.2 24 PORT CAT5E PATCH PANEL 
 
The 24 port Cat5e patch panel is intended to be used for Ethernet lines, but may also be used for FXS, 
FXO, UPN and E&M lines. 
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8.3 6205 48 PORT PATCH PANEL FOR SHIPS CABLE. 
 
The Phontech 6200 is primarily designed for use with structured cabling. When using traditional ships 
cable, the 6205 patch panel is used together with the termination module. The patch panel is 
connected to the termination module using a 25 pin DSUB cable. 
. 
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Electrical connections

 
 
 

8.4 Y-CABLE FOR 6205 PATCH PANEL 

 
 
When using this patch panel in combination with the E&M line board, and the keying inputs or 
outputs are used, a special Y-patch cable is required, Jotron item no: 18472. 

 

The black RJ-45 jack is connected to the E&M port on the Phontech 6200 unit, the red RJ-45 jack is 
the audio line and the yellow RJ-45 jack is the key IO. The red and yellow jack is inserted in the 6205 
patch panel at the desired locations. 
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